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1. Sažetak 

U radu je dan osnovni pregled GIS-a i njegova primjena u speleologiji. GIS se odnosi na Geografski 

informacijski sustav koji služi za vođenje, analizu i prikaz baze podataka s informacijama o prostoru u 

nekom referentnom koordinatnom sustavu. U prvom je dijelu objašnjena teorijska pozadina o 

koordinatnim sustavima korištenim na području Hrvatske. Zatim su navedene različite vrste 

prostornih podataka koji se primjenjuju u GIS-u. Najveći dio rada posvećen je QGIS-u, koji je 

besplatan softver otvorena koda za rad u GIS-u. Dana su objašnjenja pojedinih dijelova i funkcija te 

unosa i obrade podataka. Objašnjeni su načini prikaza te ispisa karte i na papir i za upotrebu u GPS 

aplikacijama na mobitelu. U posljednjem dijelu nalaze se prilozi s uputama. Opisani su koraci za 

prebacivanje baze podataka o speleološkim objektima, vođeni u internoj arhivi udruge ili hrvatskog 

katastra speleoloških objekata u format čitljiv GPS aplikacijama. Opisan je i postupak prebacivanja 

podataka iz GPS aplikacija u bazu podataka. 

Ključne riječi: GIS, QGIS, katastar, arhiva, HTRS96/TM, georeferenciranje 
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2. Uvod u GIS 

Prostorno snalaženje i korištenje prostornih podataka oduvijek je bio neizostavan dio 

speleologije. Za svaki speleološki objekt koji bi se pronašao i istražio vodio bi se speleološki zapisnik. 

Jedna od točaka tog zapisnika bila bi i koordinata ulaza te bi se zabilježio i položaj i pristup objektu. 

Sva tri podatka neizostavna su u zapisniku jer omogućuju da bilo tko, uz taj zapisnik, može posjetiti 

speleološki objekt, bilo zbog monitoringa, edukacije ili daljnjeg istraživanja. Dosadašnju uporabu 

karte i kompasa danas gotovo u potpunosti na terenu zamjenjuje upotreba GPS1 uređaja i mobitela s 

GPS aplikacijama. Kako bi se GPS mogao koristiti, u njega treba unijeti odgovarajuće podatke. To 

mogu biti pozadinska karta, geološka karta, točke s ulazima u speleološke objekte, ruta do kampa i sl. 

Svi se ti podaci objedinjuju i unaprijed pripremaju u određenim GIS softverima. Povlači se pitanje, što 

je to uopće GIS?  

GIS je kratica za Geografski informacijski sustav. To je računalni sustav kojim se prikupljaju, 

vode, analiziraju i prikazuju prostorni podaci (Frančula i Lapaine 2008). Što su sad to prostorni 

podaci? To su svi oni podaci koji u sebi imaju neku prostornu komponentu, odnosno, koji se mogu 

locirati negdje na Zemlji. GIS omogućuje vođenje baze podataka o speleološkim objektima u 

tablicama i povezivanje te tablice s točkama na karti. Omogućuje pripremu za teren, tako da za svaku 

točku koja se unosi u GPS postoji informacija o toj točki. Osim toga gdje se koji objekt nalazi, moguće 

je vidjeti ima li špilja naziv, ima li pločicu, je li istražena do kraja, je li potrebno proširivati... 

Za upotrebu GIS-a, potrebno je poznavanje softvera, vrste prostornih podataka, koordinata i 

koordinatnih sustava. Mogućnosti su mu jako široke i neki put korištenje može biti banalno, a neki 

put iziskuje napredna znanja različitih koordinatnih sustava, baza podataka, logičkih upita, grafičkog 

uređenja, matematike, fizike i psihologije. Do željenog cilja često ne vodi jedan put, nego postoji širok 

način mogućnosti, a sve ovisi o snalaženju korisnika. 

 

Kroz naredne stranice dana su neka pojašnjenja i načini upotrebe GIS-a s fokusom na softver 

QGIS. Uz to postoji još izobilje opcija koje nisam pokrio, a ima i još veće izobilje koje niti sam ne znam. 

QGIS nagrađuje testiranje, eksperimentiranje s podacima i opcijama te puno guglanja i gledanja 

YouTube uputa. Program je jako vrijedan, s velikom bazom korisnika koja ga konstantno razvija i 

svaka verzija je sve bolja i bolja.  

 

 

  

 
1 GPS (Globalni pozicijski sustav) se isključivo odnosi na američki navigacijski satelitski sustav. Objedinjeni 
navigacijski satelitski sustav koji uključuje i ruski GLONASS, europski Galileo i kineski Beidou naziva se GNSS 
(Globalni navigacijski satelitski sustav), ali zbog jednostavnosti je u radu korišten isključivo popularni naziv GPS. 
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3. Koordinatni sustavi 

Pozicija neke točke može se odrediti na više načina. To može biti koordinata, adresa, 

prostorni opis. Čovjeku je za snalaženje u prostoru, bez dodatnih alata, korisnija adresa ili prostorni 

opis, dok je za GIS, računalo i GPS potrebna koordinata. Uređeni par brojeva daje koordinate u 

prostoru (Varošanec i sur., 2020). Jedna koordinata raste u smjeru istoka, dok druga raste u smjeru 

sjevera. Primjer para koordinata je (403140, 4953625). Te dvije brojke same po sebi nisu dovoljne 

kako bi se smjestile u prostoru. Potrebno je znati odakle one počinju, koje im je ishodište, u kojem 

smjeru rastu, kako su okrenute u prostoru. Ti podaci se definiraju koordinatnim sustavom. Tek kad se 

poznaje u kojem je koordinatnom sustavu taj par koordinata, moguće ih je smjestiti u prostor i na 

kartu. Isti set brojeva koordinata može smjestiti točku u Hrvatsku u jednom koordinatnom sustavu, a 

u Sloveniju u drugom koordinatnom sustavu. Isto tako različite koordinate u različitim koordinatnim 

sustavima mogu određivati istu točku (Tablica 1). 

Tablica 1. Različiti koordinatni sustavi 

Koordinatni sustav E N EPSG 

HTRS96/TM 403 140 m 4 953 625 m 3765 

HDKS (5. zona) 5 522 354 m 4 952 450 m 8677 

HDKS (6. zona) 6 284 700 m 4 956 008 m 8678 

UMT-33 521 974 m 4 951 449 m 32633 

Pseudo-Mercator 1 700 677 m 5 576 936 m 3857 

λ, φ (WGS84) 
15,27744° 44,71609° 

4326 
15° 16' 38,8" 44° 42' 57,9" 

 

 

Slika 1. Zemljin elipsoid i smještaj ravnine kartografske 
projekcije (Chellappa i sur., 1997) 

Svaki koordinatni sustav definiran je 

datumom, kartografskom projekcijom i 

parametrima projekcije. Datum definira veličinu i 

položaj elipsoida kojim se aproksimira Zemlja. 

Kartografska projekcija je matematičko pravilo 

preslikavanja točaka sa Zemljina elipsoida na 

ravninu projekcije. Parametri projekcije 

definiraju smještaj i ishodište ravnine 

kartografske projekcije (Slika 1). Neki koordinatni 

sustavi nalaze se u EPSG bazi podataka, koja 

sadrži sve potrebne podatke za definiranje te 

projekcije (URL 1). Ako je sustav u bazi, on ima 

svoj EPSG kod (Tablica 1). 

Softveri koji podržavaju različite koordinatne sustave često su vezani uz EPSG bazu podataka, 

tako da je dovoljno poznavanje njihova koda kako bi se u softveru pravilno smjestio koordinatni 

sustav. 
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Trenutni službeni koordinatni sustav Republike Hrvatske je HTRS96/TM, odnosno Hrvatski 

terestrički referentni sustav. Broj 96 označava epohu mjerenja (1955,55 godina), a TM označava 

Transverzalnu Mercatorovu kartografsku projekciju. Uveden je 2004. godine (NN 114/2004, 

117/2004), iako se i danas često koristi stari koordinatni sustav. Stari službeni koordinatni sustav je 

HDKS, odnosno Hrvatski državni koordinatni sustav. HDKS je kolokvijalno poznat i kao Gauss-Krüger2. 

Osnovna razlika u pozadini ova dva koordinatna sustava je u njihovim referentnim elipsoidima, 

kojima aproksimiraju oblik Zemlje. HTRS96/TM koristi GRS80 elipsoid, kojemu je ishodište smješteno 

u centar Zemlje. To omogućuje jednostavno preračunavanje iz globalnih koordinata dobivenih GPS-

om, ali površina elipsoida ne aproksimira dobro područje same Hrvatske. HDKS koristi Besselov 

elipsoid, smješten tako da mu površina dobro aproksimira područje Hrvatske, a nedostatak je 

složenije preračunavanje iz globalnih koordinata dobivenih GPS-om, te samim time i iz HTRS96/TM. 

 

 

Slika 2. Zone preslikavanja HDKS-a (Frančula, 2004) 

Razlika na površini ta dva koordinatna 

sustava je u zonama preslikavanja. Dok 

HTRS96/TM preslikava čitavo područje 

Hrvatske u jedan koordinatni sustav, HDKS 

preslikava u dva koordinatna sustava, odnosno 

dvije zone širine 3° geodetske dužine (Slika 2). 

Zapadni dio Hrvatske preslikava se u 5. zonu, 

kojoj je središnji meridijan 15° istočno, a 

istočni dio Hrvatske preslikava se u 6. zonu, sa 

središnjim meridijanom 18° istočno. Granični 

meridijan između dviju zona je 16,5° istočno. 

Svaka zona ima prefiks 5, odnosno 6 u svom 

zapisu istočne koordinate. Ako je istočna 

koordinata 5 522 354 m, radi se o 5. zoni, a 6. 

zona ako je koordinata 6 284 700 m. Oznake 

koordinata u koordinatnim sustavima nisu 

iste, te nisu iste osnovnom matematičkom 

zapisu koordinata u koordinatnom sustavu.

Apscisa je koordinata koja raste u desno. Njezina oznaka u standardnom matematičkom zapisu je x. 

Ordinata je koordinata koja raste prema gore, a standardna matematička oznaka joj je y. U starom 

HDKS, njihove su oznake zamijenjene. Os y raste u smjeru desno, odnosno istoka, dok os x raste u 

smjeru gore, odnosno2sjevera3. Kako bi se uklonila nesigurnost, u HTRS96/TM koordinatnom sustavu 

su promijenjeni nazivi koordinata u E i N, gdje E raste u smjeru desno/istoka, a N u smjeru 

gore/sjevera (DGU, 2009). Vrijednost koordinata u oba sustava je u metrima. 

WGS84 (World Geodetic System 1984) je koordinatni sustav aproksimiran globalnim 

elipsoidom, koji koristi i GPS. Gotovo je identičan GRS80 elipsoidu, koji je osnova za HTRS96/TM 

koordinatni sustav. Vrijednosti koordinata WGS84 su u softverima izražene u stupnjevima. Kod 

prikazivanja koordinata u stupnjevima, potrebno je obratiti pažnju jesu li koordinate zapisane u 

 
2 Gauss-Krüger je općeniti naziv poprečne konformne cilindrične kartografske projekcije na elipsoidu nazvane 
po C. F. Gaussu i J. H. L. Krügeru. Transverzalna Mercatorova (TM) projekcija joj je sinonim na elipsoidu ili sferi. 
Za definiciju koordinatnog sustava je uz projekciju potrebno i navesti parametre elipsoida i projekcije, što je 
uključeno u HDKS i HTRS96/TM. 
3 Razlog zamjeni koordinata je treća os z. Tri osi čine desni koordinatni sustav, a račun geofizičkih vrijednosti je 
jednostavniji ako je z os u smjeru ubrzanja sile teže, odnosno u suprotnom smjeru od standardnog zapisa. 
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decimalnom obliku stupnja, poput 15,96171°, ili u seksagezimalnom sa izraženim stupnjevima, 

minutama ili sekundama, poput 15° 57' 42,2". Problemi često nastupe kad se seksagezimalan zapis 

zapiše u decimalnom obliku, poput 15,57422, te iz toga nije odmah jasno o kojem zapisu se radi. 

Ukoliko su u zapisu vrijednosti koje bi trebale prikazivati minute ili sekunde veće od 60, sigurno se 

radi o decimalnom zapisu stupnja. Kod 15,96171 vrijednost 96 je na mjestu minuta, a 17 na mjestu 

sekundi. Kako je 96 veće od 60, sigurno se ne radi o seksagezimalnom zapisu. Kod 15,57422 su i 57 i 

42 manje od 60, tako da je moguće da se radi o seksagezimalnom zapisu, ali je moguće i da se radi o 

decimalnom zapisu. Ako se pojavi takav slučaj, ne postoji način provjere, nego je potrebno kartirati 

obje mogućnosti i iz konteksta koordinate pokušati zaključiti o kojoj se radi.  

Stupanjske koordinate neki put mogu biti zadane i na nekom drugom elipsoidu. Na području 

Hrvatske, to može biti Besselov elipsoid iz 1841., koji je i osnova za HDKS. Ako su tako zadane 

koordinate, one mogu odstupati oko 23'' po širini, odnosno 13'' po dužini, tj. oko 750 m po širini i 300 

m po dužini. Za tako zadane koordinate ne može se primjenjivati WGS84 kao koordinatni sustav, a 

softveri često ne podržavaju neke druge elipsoide, poput Bessel 1841. Koordinate se tada trebaju 

transformirati u neki primjenjiv sustav upotrebom specijaliziranih softvera, poput T7D (URL 2). 

Koordinatni sustav koji je po zapisu koordinata vrlo sličan HTRS96/TM je UTM (Universal 

Transverse Mercator), odnosno na području Hrvatske UTM-33N. UTM na području Hrvatske nije 

često u upotrebi, osim za vojne potrebe. Neki softveri, poput OruxMaps ne nude mogućnost unosa 

koordinata u HTRS96/TM, ali nude unos u UTM, kod kojeg su vrijednosti koordinata naizgled iste. 

Kako se ne radi o istom koordinatnom sustavu, unos koordinata neće dati ispravan položaj.  

Pseudo-Mercator ili Web Mercator je koordinatni sustav koji uglavnom koriste online servisi i 

preglednici karata, poput OpenStreetMap-a, i aplikacije, poput OruxMaps. Iako se koordinate mogu 

prikazivati u različitim koordinatnim sustavima, sam prikaz karte na tim preglednicima i aplikacijama 

je u Pseudo-Mercatorovoj projekciji. Projekcija je također izražena u metrima, ali je potrebno uzeti u 

obzir pojavu velike pogreške projekcije na području Hrvatske4. Pomak od 1 m po koordinatama 

odgovara približno stvarnom pomaku od 70 cm, tj. koordinate 1700677 i 1700678 su udaljene oko 

70 cm, a koordinate 1700677 i 1701677 su udaljene oko 700 m. 

3.1. Preciznost podataka 

Koordinate ulaza u speleološki objekt najčešće se danas dobivaju pomoću GPS uređaja ili 

aplikacije, te se isto tako najčešće i pretražuju na terenu. Koordinate mogu biti dobivene pomoću 

karte, ili nekog drugog GIS softvera. Na koji se god način dolazi do tih koordinata, potrebno je uzeti u 

obzir njihovu preciznost u zapisivanju. Koordinate u HTRS96/TM ili HDKS koordinatnom sustavu su u 

metrima. Istočna koordinata E 534 555 nalazi se u projekciji 34 555 m istočno od središnjeg 

meridijana 16° 30' (koji se nalazi na koordinati E 500 000). Točnost kojom se određuje položaj na 

terenu korištenjem GPS tehnologije uglavnom je točnosti 5-10 m (URL 3), dok u nepovoljnim 

uvjetima (visoka vegetacija, blizina stijena) može biti i lošija. Nema potrebe da se koordinate u bilo 

kojim zapisnicima zapisuju većom preciznošću od 1 m. Ako je bilo kojom metodom dobivena 

koordinata ulaza u speleološki objekt kao (403140.703, 4953625.318), sve se vrijednosti iza 

decimalne točke mogu odbaciti i zapisati koordinate kao (403140, 4953625). 

 
4 Pogreška se javlja kod svake kartografske projekcije, ali je za službene koordinatne sustave RH uglavnom 
zanemariva (oko 1 dm na 1 km). 



 
 

9 

Ako su koordinate zapisane kao širina i dužina (φ, λ), nije odmah jasno kojom preciznošću je 

potrebno zapisati koordinate. Je li (15° 16' 38", 44° 42' 57") dovoljno precizno za pronalazak 

speleološkog objekta? Stupanjska preciznost ovisi o dimenzijama Zemlje i položaju na Zemlji. Ako se 

Zemlja aproksimira sferom, riječ je o geografskoj širini i dužini. Ako se Zemlja aproksimira elipsoidom, 

poput WGS84, riječ je o geodetskoj širini i dužini. Meridijani konvergiraju u polove, tako da 

geografska dužina λ od 1° blizu ekvatora i 1° blizu Sjevernog pola nije jednaka, ali geografska širina φ 

jednaka je bez obzira na položaj. Promatrajući približni položaj Hrvatske, a aproksimiranjem Zemlje 

kao sfere, polumjera 6371 km, dobiva se da je približna dimenzija 1°  geografske širine 111 km, dok 1° 

geografske dužine varira od 82 do 77 km. Iz toga se dalje dobiva da je 1' približnih dimenzija 1850 m 

geografske širine, odnosno 1300 m geografske dužine. Dimenzije 1'' su približno 30 m geografske 

širine, a 22 m geografske dužine. Te konačno dobivamo da je 0,1'' približno 3 m geografske širine, 

odnosno 2 m geografske dužine. Za potrebe zapisivanja koordinata ulaza u speleološke objekte, 

potrebno je zabilježiti u seksagezimalnom zapisu vrijednosti do desetinke sekunde, te nije potrebno 

preciznije od toga. Na sličan se način može doći do potrebne preciznosti u decimalnom zapisu 

stupnjeva, gdje je 0,00001° približnih dimenzija 1 m geografske širine i 0,8 m geografske dužine te 

nije potrebno zapisivati više od 5 decimalnih mjesta. Tablica 2 prikazuje približne vrijednosti 

preciznosti ovisne o zapisu elipsoidnih koordinata. 

Tablica 2. Prikaz preciznosti elipsoidnih koordinata 

Preciznost 

decimalnog 

zapisa 

Približna 

preciznost u 

metrima 

Primjer zapisa 

koordinate 

Preciznost 

seksagezimalnog 

zapisa 

Približna 

preciznost u 

metrima 

Primjer zapisa 

koordinate 

0,01° ~ 1000 m 15,28° 0° 01' ~ 1500 m 15° 16' 

0,001° ~ 100 m 15,277° 0° 00' 10'' ~ 300 m 15° 16' 40" 

0,0001° ~ 10 m 15,2774° 0° 00' 01'' ~ 30 m 15° 16' 39" 

0,00001° ~ 1 m 15,27744° 0° 00' 00,1'' ~ 3 m 15° 16' 38,8" 

0,000001° ~ 0,1 m 15,277443° 0° 00' 00,01'' ~ 0,3 m 15° 16' 38,83" 
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4. Prostorni podaci u GIS-u 

Prostorni podaci su bilo koji podaci koji uz sebe vežu i informaciju o položaju. Primjer 

prostornih podataka je katastar speleoloških objekata, koji uz informaciju o nazivu, dimenzijama 

objekta i mnogim drugim, sadrži i koordinate ulaza u objekt. To omogućuje da se ta baza podataka 

prikaže u prostoru na karti u nekom GIS softveru. Geometrijski podaci prostorne baze podataka su 

koordinate. Atributni podaci su svi ostali podaci u bazi, koji nisu vezani uz geometrijski prikaz. 

Metapodaci su podaci o podacima. Oni ne sadrže informacije o pojedinom objektu o bazi, već sadrže 

informaciju o samoj bazi, poput institucije ili osobe koja je izradila, datum izrade ili ažuriranja i slično. 

Osnovna podjela prostornih podataka u GIS-u je na rasterske i vektorske podatke. Podjela je 

slična kao i u računalnoj grafici te svaki od podataka ima svoju primjenu.  

4.1. Rasterski podaci 

Raster je prikaz koji se sastoji od niza piksela smještenih u mrežu. Svaki piksel jednakih je 

dimenzija. Rasterski podatak u računalnoj grafici je obična slika koja se sastoji od piksela, gdje svaki 

piksel ima određenu vrijednost ili boju. U GIS-u je ta slika, odnosno svaki piksel ujedno i položajno 

smješten u koordinatnom sustavu. Najčešći formati rasterskih podataka su uobičajeni formati slika, 

poput *.jpg i *.png. Kako bi se smjestili u prostor, uz sebe sadrže i World File. To je tekstualna 

datoteka od 6 redaka koji definiraju dimenziju jednog piksela, rotaciju slike u koordinatnom sustavu i 

koordinatu gornjeg lijevog piksela. Čest format rasterskih prostornih slika je i *.tiff koji u sebi već 

može sadržavati podatke o smještaju slike u prostoru i ne zahtjeva zasebnu datoteku.  

Rasterski podaci najčešće korišteni u GIS-u i aplikacijama su topografske karte (TK), digitalne 

ortofoto karte (DOF) i digitalni modeli reljefa (DMR, eng. DEM) (Slika 3). Najčešća primjena rasterskih 

podataka je kao pozadinska slika u aplikacijama. 

 

Slika 3. Rasterski podaci: a) TK25, b) DOF, c) DMR prikazan sjenčanjem 

Vrijednost pojedinog piksela može biti neka oznaka boje, a može biti brojka koja označava 

neku vrijednost, poput nadmorske visine. Kod rasterskih podataka je moguće prepoznati pojedine 

elemente slike, poput ceste (Slika 3a), no aplikacije ne prepoznaju tu cestu kao jedan element i nije 

moguće dobiti više informacija o njoj. Ljudsko oko prepoznaje rijeku, drveće, puteve i skelu na DOF-u 

(Slika 3b), ali ne i GIS preglednici. Kod rasterskih podatka, jedino modeli reljefa omogućuju 

jednostavnu obradu, poput pretvaranja digitalnog modela reljefa u sjenčani prikaz reljefa (Slika 3c). 

a) b) c) 
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4.2. Vektorski podaci 

Vektorski podaci u računalnoj grafici su grafički oblici definirani geometrijskim oblicima. 

Matematički su definirani i njihovi rubovi imaju zadane koordinate. Uobičajeni oblici vektorskih 

podataka su točke, linije i poligoni (Slika 4). 

 

Slika 4. Vektorski podaci: a) točke, b) linije, c) poligoni 

Točke (Slika 4a) su zadane svojim koordinatama u određenom koordinatnom sustavu. One 

nemaju veličinu, ali se u njihovom grafičkom prikazu može odabrati bilo koja veličina ili oblik. Bez 

obzira što su prikazane kružićem, križićem, kvadratićem ili nekom slikom, one su i dalje točke 

smještene samo na svojoj koordinati. Primjeri točaka u GIS-u su ulazi u speleološki objekt, te razni 

prikazi na topografskim kartama, poput špilja, jama, kota, izvora, bunara i slično. Linije (Slika 4b) čine 

međusobno povezane točke. Zadane su koordinatama svojih lomnih točaka te relacijom, odnosno 

načinom povezivanja tih točaka. Linije kao element nemaju debljinu, ali u grafici mogu biti prikazane 

bilo kojom debljinom ili uzorkom. Primjeri linijskih oblika su ceste, putevi, potoci, povremeni tokovi. 

Poligoni (Slika 4c) su površine omeđene linijama, odnosno lomnim točkama. To su jedini grafički 

elementi koji prikazuju svoju stvarnu površinu. Mogu biti prikazani ispunjeni bojom, obrubom ili 

nekim uzorkom. Primjeri poligona su šume, jezera, stjenjaci. 

Izbor načina prikaza pojedinog elementa često ovisi o predviđenom mjerilu prikaza. Kuća 

može biti prikazana kao površina, prikazujući svoje stvarne dimenzije, a može biti prikazana i kao 

točkasti simbol. Slično vrijedi i za vrtaču. Ako je većih dimenzija, može biti prikazana svojom stvarnom 

površinom, a ako je manja, može biti prikazana svojim točkastim simbolom. Veće rijeke mogu biti 

prikazane kao površine, dok manje mogu biti prikazane kao linije. 

Vektorski podaci uz sebe mogu imati vezanu bazu podataka koja povezuje pojedini 

geometrijski element s podacima iz tablice. Tako uz pojedine točke, linije ili površine može biti 

povezana atributna tablica s nizom podataka o tim elementima. Tako je u CroSpeleo (katastar 

speleoloških objekata Republike Hrvatske) bazi podataka, uz pojedini element točke ulaza u 

speleološki objekt povezana i tablica koja sadrži podatke o njegovom nazivu, broju pločice, godini 

istraživanja, položaju i pristupu i dr. (URL 4). 

Za razliku od rasterskog prikaza ceste, kod vektorskog prikaza računalo prepoznaje cestu kao 

zasebni element. Kao vektoru, omogućuje njezin odabir, te dobivanja dodatnih atributnih podataka. 

Moguće je dobiti i njezine geometrijske podatke, poput duljine.  

Vektorski se podaci vrlo jednostavno mogu pretvoriti u rasterske, najobičnijim ispisom slike iz 

grafičkog prikaza. Rasterske je podatke teže pretvoriti u vetorske te često iziskuje ručno iscrtavanje, 

odnosno vektorizaciju.  

a) b) c) 
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5. QGIS 

Postoje mnogobroji računalni programi koji omogućuju rad s prostornim podacima, njihovu 

pohranu, prikaz i analizu. To su GIS računalni softveri. Oni mogu biti komercijalni, poput ArcGIS, a 

mogu biti i besplatni, otvorenog koda, poput QGIS-a (URL 5). QGIS je počeo s razvojem 2002. godine, 

a prva verzija 1.0 objavljena je 2009. godine kao Quantum GIS. Već je s verzijom 2.0 iz 2013. ime 

promijenjeno u QGIS. Verzija 3.0 izašla je 2018. godine i konstantno se ažurira. Verzija 4.0 je u planu 

izaći u veljači 2026. godine. 

Postoje mnogobrojne verzije QGIS-a, poput trenutno najnovije 3.44.6. Uz najnoviju verziju, 

postoji i LTR (Long Term Release) verzija, koja je trenutno 3.40.14. Novosti o verzijama moguće je 

vidjeti na stranicama QGIS-a. LTR je u pravilu stabilnija verzija koja ima dulja ažuriranja i ispravljanje 

grešaka. Trenutna LTR 3.40 imala je 14 ažuriranja, dok je najnovija verzija 3.44 imala njih 6. Što je veći 

posljednji broj verzije, veći je broj ažuriranja te verzije i time je i softver stabilniji. Sve nove verzije i 

ažuriranja moguće je skinuti i instalirati na računalu, a zadane korisničke postavke ostaju iste. Već 

kod pokretanja softvera, QGIS će javiti da postoji novija verzija i ponuditi će poveznicu za 

preuzimanje. 

Prilikom pokretanja, QGIS izgleda kao (Slika 5). Sadrži prostor za prikaz i mnogobrojne alate. 

 

Slika 5. Prozor QGIS-a s oznakama sastavnih dijelova 

 

 

1 

2 

3a 

4a 

3b 

5 

4b 

4c 
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Osnovni dijelovi QGIS-a su: 

1. Prikaz karte (Map View) 

2. Traka izbornika (Menu Bar) 

3. Alati (Toolbars) 

a. Alati za projekt, navigaciju, odabir, digitalizaciju... 

b. Alati za unos podataka 

4. Ploče/Paneli (Panels) 

a. Panel za unos podataka (Browser Panel) 

b. Panel slojeva (Layers Panel) 

c. Panel za uređenje slojeva (Layer Styling Panel) 

5. Statusna traka (Status Bar) 

Pojedini paneli i alati mogu se paliti i gasiti desnim klikom na traku s alatima, prilikom čega se 

otvara izbornik sa svim dostupnim alatima i panelima (Slika 6). 

 

Slika 6. Dio dostupnih alatnih traka i panela 

Statusna traka omogućuje unos naredbi, prikazuje koordinate kursora, mjerilo prikaza karte, 

povećanje prikaza, rotaciju prikaza, ažuriranje prikaza i odabir kartografske projekcije (Slika 7). 

 

Slika 7. Statusna traka (Status Bar) 

Kroz naredna poglavlja navedene su osnovne funkcije QGIS-a, dok su dodatne mogućnosti i 

detaljnija objašnjenja opisani u QGIS Training Manual (URL 6). 
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5.1. Postavljanje koordinatnog sustava 

Po zadanim postavkama, QGIS je u WGS84 koordinatnom sustavu (EPSG: 4326). Koordinatni 

sustav projekta moguće je izmjeniti u statusnoj traci odabirom EPSG koda. Tom promjenom će se 

izmijeniti samo sustav trenutnog projekta i kod svakog ponovnog otvaranja QGIS-a će se trebati 

mijenjati. Kako bi projekt uvijek bio zadan u HTRS96/TM koordinatnom sustavu, potrebno je urediti 

početne postavke. U traci izbornika se odabere Settings > Options. Unutar novog prozora odabere se 

u lijevom izborniku CRS Handling. 

 

 

 

Slika 8. Odabir HTRS96/TM koordinatnog sustava 
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Unutar prozora za CRS for Projects potrebno je odabrati Use a default CRS i ikonu globusa. U 

novom prozoru se u Filter upiše EPSG kod za HTRS96/TM koordinatni sustav (3765) te se u popisu 

ponuđenih projekcija on i odabere (Slika 8). Neke stare verzije ne podržavaju HTRS96/TM koordinatni 

sustav, tako da je preporuka ažuriranje QGIS-a. Nakon postavljanja koordinatnog sustava, u desnom 

dijelu statusne trake trebao bi pisati EPSG kod 3765, što označava da je projekt u tom koordinatnom 

sustavu. 

5.2. Unos podataka 

QGIS podržava unos različitih vektorskih podataka. Najčešće se mogu unijeti jednostavnim 

povuci i pusti (drag-and-drop) postupkom. Moguće je povezivanje na neke online podatke i servise. 

Neke podatke potrebno je unijeti ručnim odabirom i zadavanjem koordinata. Svaki uneseni podatak 

naziva se sloj (Layer) i nalazi se u Layers Panel (Slika 9). Redoslijed u Layers Panel određuje kako se 

prikazuje sadržaj na karti. U primjeru je OpenStreetMap na dnu popisa pa je u pozadini karte. Iznad 

njega je TK25 na popisu pa je i na karti preko OSM. Zatim slijede poligoni zaštićenih područja i na 

vrhu su točke CroSpeleo-a. 

 

Slika 9. Prikaz različitih slojeva u QGIS-u 

Vektorski podaci često korišteni s GIS softverom su Shapefile i GeoPackage. Shapefile se 

sastoji od nekoliko datoteka različitih ekstenzija istog imena koje se sve moraju nalaziti u istom 

folderu kako bi funkcionirao (*.shp, *.shx, *.dbf), a može sadržavati i druge datoteke (npr. *.prj). 

Jedna Shapefile datoteka podržava samo jedan vektorski oblik (točka, linija ili poligon). GeoPackage 

se sastoji od jedne datoteke (*.gpkg) i ona podržava istovremeno spremanje više vektorskih oblika 

(točke, linije i poligoni) i više slojeva. Prilikom unosa GeoPackage koji u sebi sadrži i točke, linije i/ili 

poligone, QGIS pita koje od podataka je potrebno unijeti te svaki smjesti u zasebni sloj. 

KML i GPX su vektorski oblici koji su najčešće u interakciji s GPS uređajima i aplikacijama. 

Najčešće se koriste za snimanje rute i točaka na terenu. Pojedine aplikacije podržavaju samo jedan, a 

neke i oba formata. Prednost KML formata je mogućnost kreiranja mnogobrojnih atributnih tablica 

povezane uz geometrijske točke, dok GPX ima ograničen broj (naziv, opis i komentar). Snimljeni 

Popis slojeva 

(Layers) 

Pozadina (raster): 

- OpenStreetMap 

- TK25 

Vektorski slojevi: 

- Zaštićena područja 

(poligoni) 

- CroSpeleo (točke) 



 
 

16 

trekovi se mogu sastojati od više elemenata (linije i točke) pa je prilikom unosa potrebno odabrati 

koje je od podataka potrebno unijeti te će se svaki nalaziti u zasebnom sloju. 

DXF je vektorski format uglavnom vezan uz CAD (Computer Aided Design) programe, 

uglavnom korištenih za crtanje grafika, ali ga je moguće otvoriti i u QGIS-u. Licencirani oblik DWG nije 

moguće otvoriti u QGIS-u. 

TIFF (GeoTIFF) je rasterski format koji je moguće učitati u QGIS i koji u sebi već može 

sadržavati podatke o položaju u koordinatnom sustavu. Nedostatak TIFF-a je što vrlo često zauzima 

puno računalne memorije. Slike formata *.jpg ili *.png trebaju uz sebe imati World File istog naziva, a 

ekstenzije *.jgw ili *.pgw pomoću kojih se mogu smjestiti na koordinate. Potrebno znati u kojem su 

koordinatnom sustavu zadani parametri u World File.  

MBTiles je rasterski format koji se sastoji od jedne datoteke formata *.mbtiles. On se u sebi 

sastoji od nekoliko slika, koje se mogu mijenjati ovisno o razini približavanja karti. Jedan prikaz može 

biti na razini pregleda Hrvatske, drugi na prikazu općine, a treći na prikazu pojedine šume. 

5.3. Unos CSV podataka 

CSV (Comma Separated Values) je tekstualni oblik datoteke. Može biti u *.csv ili u *.txt 

formatu. Njih je moguće otvoriti i uređivati u bloku za pisanje (Notepad), a za naprednije funkcije 

preporučljivo je korištenje Notepad++ (URL 7). To je tekstualna tablica koja se sastoji od nekoliko 

redaka i stupaca. Svaki stupac označava pojedinu atributnu ili geometrijsku vrijednost (npr. ime, vrsta 

objekta, E koordinata, N koordinata), a svaki redak označava pojedini element (Slika 10). Iako sam 

naziv CSV sugerira kako su podaci po stupcima razdvojeni zarezom, razdjelnik (Delimiter) može biti 

bilo koji znak, a najčešće su razmak (Space), točka sa zarezom (Semicolon) ili tab. Taj format zapisa 

nije odmah jasno čitljiv sisavcima, ali je jednostavno čitljiv računalima. Isti podaci prebačeni u 

standardni tablični oblik postaju jasniji (Tablica 3). U primjeru (Slika 10) se može primijetiti kako je 

unutar CSV datoteke razdjelnik tab. U samoj datoteci se nalaze i razmaci i zarezi, ali oni ne odvajaju 

podatke, nego su sve dio jednog podatka „ime“ ili „vrsta objekta“, poput imena drugog unosa „Avion, 

lopata i štilj“ ili „jama sa špiljskim ulazom“. Kod baratanja CSV datotekom bitno je poznavanje 

razdjelnika za ispravan unos podataka. Prvi redak se ne sastoji od podataka pojedinog elementa, 

nego sadrži imena stupaca. 

 

Slika 10. CSV primjer datoteke 
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Te se datoteke najčešće koriste kao poveznica između tablične baze podataka (npr. u Excelu) 

i QGIS-a. Kako bi se CSV datoteka mogla unijeti u QGIS i položajno smjestiti, potrebno je da neki od 

stupaca budu i koordinate. CSV datoteke su u QGIS-u uvijek točkasti vektorski podaci. 

Tablica 3. CSV podaci u tabličnom obliku 

id ime vrsta objekta E N 

1 Micika jama 477346 4880112 

2 Avion, lopata, štilj jama sa špiljskim ulazom 485765 4873701 

3 Guska jama 475373 4878104 

4 Zagorski Tarzan jama 485025 4870566 

5 Vjetar s planine špilja 476254 4874899 

6 Tan du gej špilja 468364 4877858 

 

Kod stvaranja baze podataka, korisno je imati jedinstveni identifikator za svaki podatak (id), 

kako bi se podaci mogli razlikovati jer često može doći do ponavljanja imena. Npr. u CroSpeleo 

trenutno postoji 10 speleoloških objekata naziva Golubinka. 

Za unos u QGIS moguće je preko trake izbornika odabrati Layer > Add Layer > Add Delimited 

Text Layer (Slika 11). Moguće je i u alatnoj traci Manage Layers Toolbar odabrati ikonu zareza.  

 

Slika 11. Unos CSV datoteke 

Naredba otvara novi prozor za unos. Tri točke uz File name nudi pretraživanje datoteke na 

računalu. Pod File format odabere se razdjelnik ili više njih (u ovom slučaju Custom delimiters > Tab). 

Record and Field Options nudi unos imena stupaca iz prvog retka (First record has field names) i 

pravilno prepoznavanja vrijednosti (Detect field types) kojim se tekst prepozna kao tekst (string), a 

broj kao broj (integer ili double). Na Geometry Definition odabere se koji stupac predstavlja X 

koordinatu (X field - koja raste u smjeru istoka) i Y koordinatu (Y field - koja raste u smjeru sjevera) te 

u kojem se koordinatnom sustavu nalazi (Geometry CRS). Ako postoji podatak nadmorske visine, on 

se može odabrati pod Z field, ali nije obavezno. Tablica u Sample Data prikazuje primjer unesenih 

podataka i može se vidjeti jesu li ispravno uređene postavke (Slika 12). Tipka Add dodaje CSV u QGIS 

(Slika 13). 
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Slika 12. Izbornik unosa CSV datoteke 

 

Slika 13. Unesena CSV datoteka 

5.4. Unos podataka u različitim koordinatnim sustavima 

QGIS podržava rad s različitim koordinatnim sustavima. Jedan sustav se postavi za čitav 

projekt (Poglavlje 5.1 Postavljanje koordinatnog sustava), a svaki pojedini uneseni podatak može biti 

u svom koordinatnom sustavu. Ako su podaci u različitom koordinatnom sustavu bazirani na istom 
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elipsoidu, u QGIS se unesu bez dodatnih upita. Npr. projekt može biti zadan u HTRS96/TM 

koordinatnom sustavu, a potrebno je unijeti koordinate u WGS84. Oba se temelje na istom elipsoidu i 

QGIS samo unese WGS84 koordinate. Ako se u projekt u HTRS96/TM koordinatnom sustavu unose 

podaci u 5. zoni HDKS-a, a koji se temelje na različitom elipsoidu, QGIS postavi upit transformacije 

koordinata (Slika 14).  

 

Slika 14. Transformacija koordinata 

Svaka od ponuđenih metoda transformacije ima svoju deklariranu točnost (Accuracy) te 

prikazuje kartu s crvenim obrubom za koje je predviđena. Za odabir transformacije može se odabrati 

metoda koja najtočnije transformira koordinate na zadanom području. 

Koordinatni sustav pojedinog sloja moguće je promijeniti i desnim klikom na sloj u Layers 

Panel te odabirom Layer CRS te odabirom ispravnog koordinatnog sustava. 

5.5. Kreiranje i izmjena podataka 

U QGIS-u je moguće kreirati novi vektorski sloj. Nudi mogućnost izrade kao GeoPackage ili 

Shapefile, kojim će se kreirani sloj i spremiti na računalu. Moguće je izraditi i Temporary Scratch Layer 

kojim se ne sprema nova datoteka na računalu, nego se stvori privremeni sloj koji će nestati kada se 

ugasi projekt. To može poslužiti za izradu nekih pomoćnih točaka, linija ili poligona. 

Za stvaranje novog sloja, potrebno je u traci izbornika odabrati Layer > Create Layer > New 

Shapefile Layer (ili New GeoPackage Layer ili New Temporary Scratch Layer) (Slika 15). 

 



 
 

20 

 

Slika 15. Kreiranje novog sloja 

Otvara se novi prozor u kojem se odabere lokacija spremanja datoteke pod File name. Kao 

Geometry type odabere se točka (Point), linija (LineString) ili poligon (Polygon). Kao CRS odabere se 

željeni koordinatni sustav. Atribute (poput naziva, opisa i sve ostalo) moguće je dodati unutar New 

Field, gdje je potrebno pod Name upisati ime atributa, pod Type se odabere vrsta unosta (Text string 

za tekst, Integer za cijele brojeve, a Decimal double za decimalne brojeve). Ako nudi Length, unese se 

maksimalan broj znakova atributa. Tipkom Add to Field List doda se atribut u tablicu. Moguće je 

dodati proizvoljan broj atributa. Tipkom OK kreira se novi sloj (Slika 16). 

 

Slika 16. Prozor stvaranja sloja 

 

 

definiranje novog sloja 

dodavanje atributa 

uneseni atributi 
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Novi se elementi zatim dodaju u prostoru karte odabirom novog sloja u popisu slojeva, zatim 

uključivanjem tipke Toggle editing (ikona olovke) i odabirom tipke Add Point Feature. Klikom na 

području karte odabere se lokacija novog elementa i otvara se prozor za upis atributa (Slika 17). 

 

Slika 17. Dodavanje elemenata u vektorskom sloju 

Kod uređivanja slojeva (Slika 18), odabiromikone olovke (1) Toggle editing, unesene podatke 

je moguće uređivati. (2) Add Point Feature (ili Add Line Feature ili Add Polygon Feature) dodaju novi 

element. (3) Vertex Tool omogućuje pomicanje lomnih točaka elementa. (4) Move Feature služi za 

pomicanje cijelog elementa, (5) Rotate Feature omogućuje rotiranje, a (6) Scale Feature nudi 

povećanje i smanjenje elemenata. 

 

Slika 18. Alati za uređivanje vektorskih slojeva 

Nije moguće sve vektorske slojeve uređivati. Ako su u QGIS uneseni Shapefile ili GeoPackage, 

u njih je moguće dodavati nove elemente i uređivati postojeće. Slojeve u CSV, KML, GPX i DXF 

formatu nije moguće uređivati u QGIS-u, nego su oni samo za čitanje (read-only). U njima se ne mogu 

uređivati niti geometrijski elementi, niti atributni podaci. Nakon završetka uređivanja, ponovno se 

mora pritisnuti ikona olovke kako bi se prestalo uređivanje sloja. 

1 2 3 

4 5 6 
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5.6. Spajanje na online servise 

Na pojedine datoteke moguće se spojiti putem online servisa. To su WMS i XYZ za rasterske 

podatke i WMF za vektorske podatke. Za spajanje na online servis potrebno je imati WMS/WFS/XYZ 

link koji nudi poslužitelj. Primjer online servisa je Topografska karta TK25, koja se nalazi na domeni 

Državne geodetske uprave na poveznici: https://geoportal.dgu.hr/services/tk/wms (važeće danom 8. 

siječnja 2026.). Kartu putem tog linka nije moguće otvoriti preko web browsera, već služi GIS 

softverima i aplikacijama za povezivanje i pregled karte. Za spajanje na WMS, potrebno je u traci 

izbornika odabrati Layer > Add Layer > Add WMS/WMTS Layer... (Slika 19). WFS i XYZ slojevi se 

dodaju na sličan način, ali svojim odgovarajućim naredbama unutar Add Layer izbornika. 

 

Slika 19. Unos WMS slojeva 

Potom se otvara novi prozor u kojem se bira postojeća veza na WMS iz padajućeg izbornika i 

tipkom Connect se na nju povezuje, ili se kreira nova veza tipkom New (Slika 20). 

 

Slika 20. Izbor nove WMS poveznice 

Odabirom New otvara se novi prozor u koji je potrebno upisati pod Name proizvoljan naziv 

novog sloja i pod URL se upisuje poveznica na WMS sloj (Slika 21). Naziv koji se ovdje upisuje može 

biti proizvoljan, a za jednostavniju organizaciju poveznica, preporučljivo je dodavati najprije ime 

institucije koja je kreirala WMS i zatim naziv tog WMS-a, npr. DGU - TK, DGU - HOK, DGU - DOF 2023-

24, HGI - Geološke 300 000, HHI – Male pomorske karte i slično. U Prilogu 6.1. nalazi se popis korisnih 

WMS, WFS i XYZ poveznica. 
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Slika 21. Kreiranje nove WMS poveznice 

Kad u QGIS-u postoje poveznice, iz padajućeg izbornika se odabere željeni WMS sloj. Na 

njega se poveže pomoću tipke Connect. U prozoru se pojavi popis dostupnih slojeva u toj WMS 

poveznici (Slika 22). Odabere se željeni i tipkom Add se unese u QGIS projekt (Slika 23). 

 

Slika 22. Odabir WMS slojeva 

Izmjena poveznice je moguća tipkom Edit, a tipkom Remove ju se uklanja iz popisa. 
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Slika 23. Unesen WMS sloj (TK25) 

5.7. Spremanje ili izvoz slojeva 

Ako je u QGIS učitan neki sloj, npr. CSV, a potrebno ga je spremiti u neki drugi oblik, npr. KML 

za daljnje korištenje u OruxMaps, potrebno ga je spremiti, odnosno izvesti (Export) iz projekta. U 

Layers Panel, na željeni sloj se desno klikne te se odabere Export > Save Feature As... (Slika 24) 

 

Slika 24. Izvoz podataka 
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Slika 25. Postavke izvoza 

Zatim se otvara novi prozor unutar 

kojeg se odaberu postavke izvoza (Slika 25). 

Kao Format se odabere željeni format (npr. 

KML). File name služi za spremanje lokacije i 

naziva datoteke. U CRS se odabere željeni 

koordinatni sustav. 

U tablici popisa atributa se odaberu 

oni atributi koje je potrebno izvesti u novu 

datoteku. 

Ako su točke unesene u QGIS s 

visinskom koordinatom (Z), moguće ju je 

izvesti odabirom Include z-dimension. 

Ako neki atribut predstavlja ime, može 

ga se zadati KML-u kao ime u polju NameField. 

Kad se urede željene postavke, tipkom 

OK se datoteka sprema na željenu lokaciju. 

Detaljne upute prijenosa podataka iz 

Excel tablice korištenjem CSV unosa te 

spremanje u KML format nalazi se u Prilogu 

6.2., dok se upute za prijenos podataka iz GPX 

u Excel nalaze u Prilogu 6.3. 

 

 

 

5.8. Atributni podaci 

Kad su u QGIS uneseni vektorski podaci koji sadrže atributne podatke, može se te atribute 

pregledati u obliku tablice pritiskom na tipku u alatnoj traci Open Attribute Table (Slika 26). Pojedine 

elemente (retke) se može selektirati, a pritiskom na gornji lijevi ugao tablice selektiraju se svi redovi. 

Ikona povećala u atributnoj tablici služi za približavanje pregleda karte na odabrane elemente. 

Pritiskom na naziv stupca, svi elementi se u tom stupcu sortiraju abecedno, odnosno brojke po 

veličini. Ako su uneseni podaci u vektorskom obliku Shapefile ili GeoPackage, ikona olovke u alatnoj 

traci atributne tablice omogućuje uređivanje i atributnih podataka, a disketa sprema uređenje. 

Nakon uređivanja, potrebno je ponovno pritisnuti ikonu olovke kako bi se prestalo uređivati. 
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Odabrane retke sa svim njihovim atributima može se kopirati i zalijepiti u Excel ili Blok za pisanje 

(Notepad).  

 

Slika 26. Atributna tablica 

5.9. Uređivanje stila 

Kad su podaci uneseni kao slojevi, njihov prikaz se može urediti. Svakom novododanom sloju 

QGIS doda nasumičnu boju. Za uređivanje, potrebno je odabrati sloj za uređivanje u Layers Panel te 

se pritiskom na tipku kista (Open Layer Styling Panel) s desne strane otvara panel uređenja stila (Slika 

27). Dvostrukim klikom na sloj može se otvoriti i prozor svojstva sloja (Layer properties) u kojem je 

moguće i uređivanje stila sloja. 

 

Slika 27. Uređenje stila sloja 

Ovisno o vrsti vektorskog sloja (točke, linije ili poligoni), panel uređenja stila nudi slične, ali 

različite mogućnosti (Slika 28). Načini uređenja su praktički beskonačni. 



 
 

27 

 

Slika 28. Panel stilova za točke, linije i poligone 

U prvom padajućem izborniku se bira koji se sloj uređuje.  

Drugi padajući izbornik nudi mogućnost uređenja svih elemenata korištenjem jednog simbola 

(Single Symbol), kategorizirano ovisno o određenom atributu (Categorized), skalom boja ovisno o 

određenom numeričkom atributu (Graduated) te mnoge druge opcije. 

Slijedi prikaz simbola s popisom elemenata od kojih se sastoji. Pritiskom na tipku + može se 

dodati još simbola za jedan element. 

Zatim se bira boja (Color), transparentnost (Opacity), veličina (Size) i rotacija (Rotation). 

Veličina se može izraziti na više načina. Ako su zadane jedinice Millimeters, Points, Pixels ili Inches, 

veličina simbola bude uvijek ista, bez obzira na mjerilo prikaza. Ako su zadane jedinice Meters at 

Scale ili Map Units, veličina simbola će se mijenjati u ovisnosti o mjerilu prikaza, a bit će konstantne 

dimenzije u prirodi. 

Nakon toga QGIS nudi neke unaprijed određene simbole slojeva, koje je moguće još dodatno 

urediti. 

Pod Layer Rendering uređuje se prikaz čitavog sloja, a ne samo pojedinog elementa.  
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Slika 29. Uređenje oznake 

Iduća tipka u alatnoj traci uređenja stilova 

je uređenje oznake (Slika 29). Ovdje se nudi 

mogućnost dodavanja teksta uz pojedinu točku. 

Izborom Single Labels će jedno pravilo 

označavanja vrijediti za sve elemente u sloju. Osim 

Single Labels, postoji i mogućnost uređivanja po 

određenim pravilima. 

Kao Value se odabere podatak iz atributne 

tablice koji će se prikazivati uz oznaku, dok simbol 

epsilon nudi slikoplet dodatnih mogućnosti 

uređivanja (npr. prikaz više vrijednosti iz tablice 

atributa, poput istovremenog prikaza broja pločice 

i imena objekta) 

Slijedi nekoliko tabova kojima se uređuje 

prikaz teksta. U prvom se tabu (Text) uređuje font, 

veličina i boja teksta. Veličina (Size) ponovno nudi 

mogućnost prikaza u ovisnosti o mjerilu ili u 

prirodnoj veličini. 

Treći tab (Buffer) omogućuje izradu 

obruba oko teksta. 

Peti tab (Background) tekstu dodaje okvir i 

pozadinu (Slika 30). I obrub i pozadina nude izbor 

veličine, boje i prozirnost. 

 

 

 

 Slika 30. Prikaz oznaka, s obrubom i s pozadinom 

 

Rasterski slojevi imaju manje mogućnosti uređivanja. Za rastere postoje uobičajne funkcije 

računalne grafike (Slika 31). Može im se uređivati svjetlina (Brightness), zasićenost (Saturation) i 

kontrast (Contrast) boja te nudi nekoliko mogućnosti sive skale (Grayscale).  
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Prozirnost se može urediti na dva načina. Global Opacity smanjuje prozirnost pojedinog sloja. 

Od potpuno neprozirnog do potpuno prozirnog. Drugi je način unutar Layer Rendering odabrati 

Blending Mode > Multiply. Time se ne stvara prava prozirnost, nego se pomnože vrijednosti dvije 

slike da stvore novu na ekranu. Na taj način bijela boja (npr. pozadina karte) u potpunosti nestane, a 

ostaju samo tamniji elementi slike (Slika 32). 

 

   

Slika 31. Uređenje rastera 
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Slika 32. Običan prikaz rastera, prikaz s 50% transparentnosti i prikaz načinom Multiply 
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Ako uneseni raster nema RGB skalu boja, nego svaki piksel ima svoju vrijednost, poput 

digitalnog modela reljefa (DMR), gdje vrijednost svakog piksela odgovara nadmorskoj visini, on se 

prikazuje sivom skalom boja, gdje je crna boja najniža, a bijela najviša. To predstavlja opciju 

Singleband gray. Postoji i opcija izbora Singleband pseudocolor, gdje vrijednosti neće biti sive, nego 

izabrane skale boja (Slika 33). Primjeri prikaza se mogu vidjeti na (Slika 34). 

   

Slika 33. Uređenje vrijednosti kao siva skala i skala boja  

  

Slika 34. Prikaz istog područja sivom skalom i skalom boja 
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Takve rastere je moguće prikazati i kao osjenčane odabirom Hillshade metode (Slika 35, Slika 

36). 

 

Slika 35. Izbor Hillshade 

 

Slika 36. Prikaz Hillshade 

Stil uređenja moguće je spremiti kao zasebni *.qml 

dokument i otvoriti ga u drugom projektu. Potrebno je 

dvoklikom na sloj u Layers Panel otvoriti prozor Properties, 

na čijem se dnu nalazi izbornik Style te se odabere Save Style 

za spremanje stila i Load Style za učitavanje (Slika 37). Ako je 

*.qml datoteka istog naziva i u istom folderu kao i datoteka 

sloja, prilikom svakog učitavanja sloja u QGIS će se preuzeti 

taj stil. 

 

 

Slika 37. Spremanje i učitavanje stila 

5.10. Interakcije s prikazom karte 

U središnjem dijelu QGIS-a nalazi se prikaz karte sa svim učitanim slojevima. Za navigaciju 

kartom koristi se miš. Prikaz se pomiče srednjom tipkom miša. Približava se i udaljava kotačićem 

miša, a ako se kotačić vrti s pritisnutom tipkom CTRL, manji će biti pomaci. Desnom tipkom miša na 

pojedini sloj može se pritisnuti tipka Zoom to Layer, čime će se prikaz približiti na čitav sloj.  

U alatnoj traci postoje brojne mogućnosti za navigaciju i interakciju s kartom (Slika 38).  
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Slika 38. Alatna traka 

Alatna traka za navigaciju služi za kretanje po karti. Ikona šake (Pan Map) služi za pomicanje. 

Povećalo sa strelicama (Zoom Full) služi za povećanje na čitav prikaz. Ostale tipke navigacijske alatne 

trake (Map Navigation Toolbar) služe za različite vrste pomicanja i približavanja. 

U alatnoj traci za selektiranje (Selection Toolbar) nalaze se brojne mogućnosti selektiranja 

elemenata pojedinog sloja. Nije moguće istovremeno selektirati elemente iz više različitih slojeva. 

Onaj sloj u kojem se želi selektirati element potrebno je odabrati u Layers Panel. Prva ikona kod 

selektiranja s oznakom kursora (Select Features by Area or Single Click) omogućuje crtanje 

pravokutnika na ekranu i selektira sve elemente unutar tog pravokutnika. Pojedinim klikom na 

element može se selektirati taj element. Ako je neki element već odabran, a želi se dodati još 

elemenata u odabir, potrebno je držati CTRL prilikom novog selektiranja. Tipka selektiranja s tablicom 

(Select features by Value) omogućuje selektiranje elemenata po određenim vrijednostima u 

atributnoj tablici (npr. selektiraj sve speleološke objekte čija oznaka pločice sadrži „SKOL“). Tipka 

selektiranja s ikonom lokacije (Select by Location) omogućuje odabir na temelju prostornih upita (npr. 

ako je učitan poligon Parka prirode Velebit i točke CroSpeleo, mogu se pretražiti svi objekti koji se 

nalaze unutar Parka). 

U alatnoj traci atributa (Attributes Toolbar) ima ikona sa slovom i (Identify Features) koja služi 

da se klikom na element na karti prikazuju njegovi geometrijski i atributni podaci. Klikom na pojedini 

piksel rasterskog podatka prikazuje se vrijednost tog piksela. Ikona abakusa (Open Field Calculator) 

služi za izradu novih atributa na temelju postojećih ili na temelju geometrije. Ikona tablice (Open 

Attribute Table) otvara atributnu tablicu sloja. 

Ikona ravnala (Measure Line) služi za mjerenje udaljenosti. Uz nju se nalazi padajući izbornik 

koji nudi alate za mjerenje površine (Area), kuta (Angle) i azimuta (Bearing).  

 

5.11. Georeferenciranje 

Ako postoji slika neke karte, a koja uz sebe nema World File ili neki drugi način kojom se 

može smjestiti u koordinatni sustav, nju je potrebno georeferencirati. Georeferenciranje je postupak 

pridruživanja koordinata karti, odnosno postupak smještaja karte u koordinatni sustav. Kako bi se to 

moglo ostvariti, potrebno je prepoznati identične točke na karti koja se georeferencira i točke na 

prikazu u QGIS-u. Idealan slučaj je ako na karti postoji koordinatna mreža s označenim koordinatama 

u koordinatnom sustavu. Tada se u postupku može zadati kojem pikselu odgovara koja koordinata. 

Ako ne postoji koordinatna mreža, potrebno je prepoznati neke identične točke na prikazu na karti i u 

QGIS-u (npr. raskrižja, ušća, granice, vrhovi i sl.). U sljedećem primjeru će se georeferencirati po 

koordinatama. 

Od Hrvatskog geolološkog instituta preuzeta je Osnovna geološka karta SFRJ 1:100.000, List 

Varaždin L33–69. (Šimunić i sur., 1983) (Slika 39). Njezinim pregledom, ustanovljeno je da ima 

navigacija selektiranje atributi mjerenje 
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koordinatnu mrežu, te da koordinate imaju zapis npr. 5615, 5100 (Slika 40), ali nigdje ne piše u kojem 

je koordinatnom sustavu. Za pretpostaviti je iz datuma publikacije i zapisa da je riječ o 5. zoni HDKS te 

da su to koordinate (5 615 000, 5 100 000). S obzirom da je ucrtana mreža i zadane su koordinate, 

može se nastaviti s georeferenciranjem. 

 

Slika 39. Geološka karta Varaždin 

 

 

Slika 40. Koordinate na geološkoj karti 
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Za pokretanje alata za georeferenciranje, potrebno je u traci izbornika odabrati Layer > 

Georeferencer (Slika 41). 

 

Slika 41. Pokretanje georeferenciranja 

Otvara se novi prozor gdje se klikom na tipku Open Raster odabire slika za georeferenciranje 

(Slika 42). 

 

Slika 42. Prozor za georeferenciranje 

Nakon učitavanja, već je pokrenut alat za izbor GCP (Ground Control Points), odnosno 

identičnih točaka koje služe za georeferenciranje. U središtu alatne trake prozora postoje tipke za 

dodavanje (Add), brisanje (Delete) i pomicanje (Move) identičnih točaka. Mišem se može približavati i 

pomicati po karti. Potrebno je na slici približiti se na koordinatnu mrežu gdje se nalazi sjecište 

koordinata te se klikom miša odabere ta točka. Otvara se novi prozor u koji je potrebno unijeti 

koordinate s karte (Slika 43). 
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Slika 43. Unos identičnih točaka 

Ako na slici nisu zadane koordinate, u ovom se koraku bira tipka From Map Canvas i 

potrebno je kliknuti na identičnu točku na preglednoj karti QGIS-a (npr. raskrižje, ušće...).  

Ovisno o izboru metode georeferenciranja, potrebno je unijeti barem tri, a poželjno je i više 

identičnih točaka koje se nalaze na što većem razmaku. U primjeru je uneseno njih 4 na svakom uglu 

karte (Slika 44). 

 

Slika 44. Unesene identične točke 



 
 

37 

Uz svaku točku nalazi se crvena linija pomaka. Ona bi trebala biti mala. Ako su te linije veće i 

nasumična smjera (Slika 45), došlo je do neke greške i najbolje je ponoviti unos identičnih točaka i 

unos njihovih koordinata. 

 

Slika 45. Neispravno unesene identične točke 

Klikom na tipku zlatnog kotačića (Transformation Settings) (Slika 46) otvara se prozor s 

postavkama georeferenciranja (Slika 47). 

 

Slika 46. Pokretanje postavka georeferenciranja 
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Slika 47. Postavke georeferenciranja 

U postavkama je potrebno odabrati 

metodu transformacije, koja može ostati 

Helmert. Druge metode mogu deformirati prikaz 

karte i u pravilu se koriste kad je karta loše 

skenirana ili je u drugoj kartografskoj projekciji. 

U Target CRS se odabere željeni 

koordinatni sustav. Bez obzira što je karta 

izrađena u HDKS, ona se može georeferencirati u 

HTRS96/TM. 

Pod Output file se odabere lokacija 

spremanja datoteke.  Time će se kreirati nova 

slika u TIFF formatu. Moguće je umjesto toga 

odabrati i Create world file only, čime će se 

stvoriti samo World File uz sliku. Prednost TIFF-a 

je što se sastoji samo od jedne datoteke, ali je 

velikog formata. World File zauzima malo 

memorije, ali uvijek je za georeferenciranu sliku 

potrebno imati dvije datoteke (samu sliku i 

World File). 

Tipkom OK spreme se postavke.

Da bi se pokrenulo georeferenciranje, u prozoru georeferenciranja potrebno je odabrati tipku 

zelena trokuta (Start Georeferencing) (Slika 48), čime će se postupak pokrenuti, kreirat će se nova 

datoteka na računalu i učitati u projekt (Slika 49). 

 

Slika 48. Pokretanje georeferenciranja 
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Slika 49. Georeferencirana karta 

U ovom je primjeru u uređivanju stila karte pod Layer Rendering odabran Blending mode > 

Multiply, a pozadinska karta je TK25. 

5.12. Kreiranje offline karte 

Kad se u QGIS unesu svi željeni slojevi i urede kako je potrebno, prikaz karte se može spremiti 

kao rasterska slika. Ta se slika može učitati u QGIS, a može se unijeti i u OruxMaps. Format ispisa je 

MBTiles. Alat se pokrene tako da se u statusnoj traci u donji lijevi prostor za unos upiše „mbtiles“ i 

odabere Generate XYZ Tiles (MBTiles) (Slika 50). 

 

Slika 50. Pokretanje naredbe Generate XYZ Tiles (MBTiles) 

Potom se otvara novi prozor gdje se uređuju parametri ispisa (Slika 51). 
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Extend bira područje ispisa. S Draw on Map Canvas se na prikazu karte odabere područje 

ispisa. Može se odabrati i Calculate from Layer, čime se odabere sloj maksimalnog područja ispisa. 

Minimum i Maximum zoom postavljaju najveću i najmanju razinu povećanja. Vrijednosti se 

kreću od 0 do 20. Što je veća vrijednost, više će pločica (Tiles) biti kreirano, a neće se nužno povećati i 

kvaliteta, ali će zauzimanje memorije eksponencijalno rasti. Minimum je dovoljno početi s 8, iako i 

manje vrijednosti neće znatno utjecati na količinu memorije. Maximum je za karte poput TK25 

dovoljno postaviti na 15, za HOK na 17, a za DOF na 16. To ovisi o kvaliteti i detaljnosti karte, tako da 

je moguće postaviti i drugačije parametre. 

Tile format se može postaviti kao JPG. 

Output file određuje lokaciju spremanja i naziv datoteke. Problemi mogu nastati ako se u 

nazivu ili adresi lokacije na računalu nalaze znakovi poput č, ć, đ, š i ž. Najbolje bi bilo izbjegavati te 

znakove za MBTiles. 

Run pokreće kreiranje MBTiles datoteke koja se može ponovno učitati u QGIS (Slika 52). 

 

Slika 51. Parametri spremanja MBTiles karte 
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Slika 52. Karta spremljena u MBTiles formatu 

5.13. Ispis projekta 

Prikaz karte u projektu može se ispisati u PDF format. Ispis se pokreće u traci izbornika 

odabirom Project > New Print Layout... (Slika 53). 

 

Slika 53. Pokretanje ispisa karte 
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Otvara se novi prozor zvan Layout. Sastoji se od središnjeg prostora koji predstavlja papir koji 

će se ispisati u PDF te mnogobrojnih alata (Slika 54). Desnim klikom na područje papira može se 

pokrenuti alat za uređenje dimenzija ispisa naredbom Page Properties... gdje se može odabrati 

unaprijed zadana dimenzija ispisa (npr. A4) ili se postavi proizvoljna. 

 

Slika 54. Postavljanje Layout-a 

S lijeve strane prozora postoje razni alati za dodavanje sadržaja na papir (Slika 56). Osnovni 

alat je dodavanje karte (Add Map). Kada se selektira, na papiru je potrebno iscrtati dimenzije željene 

karte. Ucrtavanjem, ona se pojavljuje na papiru i dodaje na popis unesenog sadržaja s desne strane 

prozora. Ispod tog popisa, nalaze se svojstva odabranog sadržaja. Ovdje se može urediti mjerilo 

(Scale), dodati koordinatna mreža (Grid), urediti položaj i veličina (Position and Size), dodati okvir 

(Frame) i još mnogo drugih opcija. 

U izborniku alata s lijeve strane prozora nalaze se i dvije tipke za pomicanje. Prva služi za 

pomicanje i promjenu dimenzija unesenih sadržaja (Select/Move item). Druga služi za pomicanje 

sadržaja selektirane karte (Move item content) koji omogućuje pomicanje po pregledu karte i 

povećanje, odnosno smanjenje prikaza. 

Slijede drugi brojni alati za dodavanje sadržaja, poput slika (Add Picture), teksta (Add Label), 

legende (Add Legend), mjerila (Add Scale Bar), znaka sjevera (Add North Arrow), geometrijskih oblika 

(Add Shape) te raznog drugog sadržaja. U svojstvima sadržaja karte može se ponaosob urediti svaki 

uneseni element koji je trenutno odabran. 

Neke dodane stvari, poput legende, mjerila i znaka sjevera, moraju biti vezane uz kartu. 

Moguće je u Layout dodati na papir više karata različitih mjerila, sadržaja i rotiranosti pa je potrebno 

naznačiti kod unosa tog sadržaja na koju se kartu odnosi. 
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Kod mjerila je potrebno urediti njegov stil, odnosno hoće li biti numeričko ili grafičko, te koji 

stil grafičkog (Slika 55). 

 
Slika 55. Različiti načini prikaza mjerila (nije u mjerilu) 

 
Slika 56. Uređeni Layout 

 

Slika 57. Ispis PDF-a 

Kad se prikaz ispisa uredi po željama, 

sadržaj se ispisuje u PDF pokretanjem u 

izbornoj traci Layout > Export as PDF (Slika 

57). Odabere se lokacija i naziv ispisa nakon 

čega QGIS pita neka svojstva ispisa na što 

tipka Save sprema PDF (Slika 58). 

pomicanje unesenih stvari/karte 

pomicanje sadržaja karte 

dodavanje karte 

dodavanje ostalog sadržaja 

popis unesenog 
sadržaja 

svojstva selektiranog sadržaja 
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Slika 58. Spremljeni PDF iz projekta 

5.14. Spremanje projekta 

Učitavanjem pojedinih slojeva u QGIS stvara se poveznica na njih na računalu. Kad se unesu 

podaci, oni se ne unesu u QGIS projekt, kao što bi se npr. slika unesena u Word dokument nalazila u 

samom dokumentu. Prilikom svakog otvaranja projekta, QGIS traži te podatke na njihovoj adresi na 

računalu. Kad se QGIS spremi, spreme se samo poveznice na te podatke i njihovo uređenje, kao i sve 

postavke tog projekta. Sprema se klikom na ikonu diskete (Save Project) te se odabere lokacija 

spremanja. 

Ako se nakon spremanja neki učitani sloj s računala izbriše ili samo preseli u neki drugi folder, 

QGIS ga više neće moći naći i izbaciti će grešku (Slika 59). Ako podaci i dalje postoje na računalu, 

moguće ih je ručno pretražiti i odabrati. Potrebno je odabrati nedostajali sloj i tipkom Browse 

pretražiti na računalu njegovu novu lokaciju. Ukoliko tog sloja više nema, može se odabrati Keep 

Unavailable Layers, čime poveznica ostaje u projektu, ali nije ništa učitano, ili Remove Unavailable 

Layers, čime se briše poveznica. 

 

Slika 59. Greška učitavanja slojeva 
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6. Prilozi 

6.1. Popis poveznica WMS, WMF i XYZ slojeva5 

WMS 

DGU - HOK https://geoportal.dgu.hr/services/hok/wms 

DGU - TK https://geoportal.dgu.hr/services/tk/wms 

DGU - DOF 2011 https://geoportal.dgu.hr/services/inspire/orthophoto_2011/wms 

DGU - DOF 2014/16 https://geoportal.dgu.hr/services/inspire/orthophoto_2014-2016/wms 

DGU - DOF 2017/18 https://geoportal.dgu.hr/services/inspire/orthophoto_2017_2018/wms 

DGU - DOF 2019/20 https://geoportal.dgu.hr/services/inspire/orthophoto_2019_2020/wms 

DGU - DOF 2021/22 https://geoportal.dgu.hr/services/inspire/orthophoto_2021_2022/wms 

DGU - DOF 2023/24 https://geoportal.dgu.hr/services/inspire/orthophoto_2023_2024/wms 

DGU - DOF LiDAR 
2022/23 

https://geoportal.dgu.hr/services/inspire/orthophoto_lidar_2022_2023/
wms 

HGD - Geološke karte 
1:300 000 

https://transformiraj.nipp.hr/ows/services/org.2.abf7ddc6-7578-4070-
a9db-c291a42e55c6_wms?SERVICE=WMS&Request=GetCapabilities 

Hrvatske šume http://gis.hrsume.hr/hrsume/wms?version=1.3.0 

Hrvatske vode https://servisi.voda.hr/zasticena_podrucja/wms 

HHI - Male pomorske 
karte 

https://tiles.arcgis.com/tiles/tDYJmhP975urQUZt/arcgis/rest/services/mk
_v2/MapServer/WMTS?service=WMTS&request=GetCapabilities 

WFS 

Bioportal https://services.bioportal.hr/wfs 

DGU - RGI https://rgi.dgu.hr/geoserver/wfshr/wfs 

MGIPU, Geohazardi https://gis1.mgipu.hr/srv1/RGN_MGIPU_Public/wfs 

XYZ 

OpenStreetMap https://tile.openstreetmap.org/{z}/{x}/{y}.png 

OpenTopoMap https://tile.opentopomap.org/%7Bz%7D/%7Bx%7D/%7By%7D.png 

Google Maps https://mt1.google.com/vt/lyrs=m&amp;x=%7Bx%7D&amp;y=%7By%7D
&amp;z=%7Bz%7D 

Google Satellite https://mt1.google.com/vt/lyrs=s&amp;x=%7Bx%7D&amp;y=%7By%7D&
amp;z=%7Bz%7D 

Google Satellite 
Hybrid 

https://mt1.google.com/vt/lyrs=y&amp;x=%7Bx%7D&amp;y=%7By%7D&
amp;z=%7Bz%7D 

 

  

 
5 Poveznice su važeće danom 8. siječnja 2026. 
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6.2. Upute za prijenos podataka iz Excela u KML 

Bilo koja Excel baza podataka može se prenijeti u KML format korištenjem QGIS-a. To može 

biti interna arhiva udruge, a u primjeru će se preuzeti CroSpeleo baza podataka u Excel formatu te će 

se nastaviti raditi samo s podacima Primorsko-goranske županije. Sve ispisane koordinate bit će 

cenzurirane. 

Iz CroSpeleo Pregleda objekata, potrebno je odabrati Preuzmi podatke > Preuzmi podatke o 

objektima. 

 

Preuzeti podaci su u Excel formatu. Otvore se u programu. 
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Pojedini unosi se nalaze u više redaka. Najčešće su to opisi objekata te položaj i pristup. To 

buni CSV format tako da je potrebno svaki element prebaciti u jedan redak. Sa CTRL + h se otvori 

prozor Replace te se pod Find what upiše CTRL + j, a u Replace with se upiše točka sa zarezom te 

odabere Replace All. 

 

Napomena: nakon uređivanja tablice, može se dodati u Excel novi stupac koji će poslužiti kao 

ime objekta u prikazu, ako je potrebno prikazati u OruxMaps npr. naziv objekta i broj pločice ili status 

u arhivi (npr. „Jurišina špilja (023-069)“ ili „Lisičja špilja (potrebno kopati)“). Funkcija koja spaja ćelije 

je &, a dodani tekst je potrebno upisati unutar navodnika.  Naziv tog stupca neka bude „Name“. Ovaj 

korak je proizvoljan. 

 

 

Cijela tablica se zatim selektira sa CTRL + a i kopira sa CTRL + c. Otvori se nova prazna 

tekstualna datoteka te se sa CTRL + v zalijepe podaci. Razdjelnik kad se lijepi iz Excel datoteke je tab. 
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Podaci se u QGIS ubace s Layer > Add Layer > Add Delimited Text Layer, ili ikonom zareza. 

 

Pod File name se odabere datoteka. Kao Delimiter se odabere samo Tab. Quotes i Escape 

trebaju biti prazni. First record has field names i Detect fields se selektiraju.  

Pod Geometry Definition se odaberu HTRS koordinata X i HTRS koordinata Y, nadmorska 

visina kao Z filed te HTRS96/TM kao Geometry CRS. Tipkom Add se doda u QGIS. 
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Uneseni podaci se pojave na karti (u pozadini je OpenStreetMap) 

 

Desnim klikom na sloj se odabere Export > Save Feature As ... 
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Postavke ispisa su: 

 

Format: KML 

File name: Lokacija i ime 

CRS: HTRS96/TM 

 

Selektiraju se željeni atributi za 

ispis 

 

 

 

 

 

 

Include z-dimension se uključi 

 

 

 

 

NameField: Ime objekta (bilo koji 

atribut može biti upisan u 

NameField i to je onaj koji će se 

prikazivati u OruxMaps uz točku) 

OK sprema datoteku 

 

Preporučljivo je da se kod spremanja CroSpeleo baze u ime upiše i datum preuzimanja, kao 

npr. CroSpeleo_2026-01-24.kml, kako bi se moglo znati s kojim datumom je ažurna baza. 
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Kreirani KML se otvori u bloku za pisanje te se unutar koda doda ime datoteke kao: 

<name>CroSpeleo 2026-01-24</name> 

na početku dokumenta između Document i Schema i nakon toga se spremi dokument. 

 

Time je KML spreman za prebacivanje na mobitel i otvaranje u OruxMaps. 

 

Kako bi se KML smanjio, može ga se pretvoriti u KMZ format, koji je kompresirana datoteka. 

Desnim klikom na KML datoteku na računalu, odabere se neki način kompresije („zipanja“) datoteke. 

U ovom primjeru je to Add to archive... 
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Urede se postavke tako da se odabere format ZIP te se sa OK sprema datoteka. 

 

Ekstenzija se ručno promjeni iz *.zip u *.kmz i može se primjetiti da je dokument značajno 

manji. Čitav CroSpeleo u KML formatu ima preko 20 MB, dok KMZ ima manje od 4 MB. 

 

Prebacivanjem u mobitel i otvaranjem kao Overlay u OruxMaps, dobiva se KML sa svim 

podacima katastra, ili u ovom primjeru, samo Primorsko-goranske županije. 
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6.3. Upute za prijenos podataka iz GPX u Excel 

Ako su neke točke snimljene GPS-om na terenu, njih se može prebaciti u Excel s izmjerenim 

koordinatama i unesenim nazivima i opisima. 

S drag-and-drop se ubaci GPX ili KML datoteka izvezena iz mobitela u QGIS. 

 

Otvaranjem atributne tablice, može se primijetiti kako ne postoji atributni zapis koordinata, a 

geometrijski zapis je u stupnjevima. Potrebno je izračunati HTRS96/TM koordinate. Kako je CSV read-

only, potrebno ga je pretvoriti u GeoPackage ili Shapefile. 

Desnim klikom na Layer odabere se Export > Save Feature As... 
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Urede se parametri kao: 

 

Format: Geopackage 

File name: Lokacija i ime 

CRS: HTRS96/TM 

 

 

 

 

 

 

 

 

Add saved file to map 

OK za spremanje 

Odabere se novokreirani sloj i odabere ikona abakusa (Field Calculator). 
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U Field Calculator je potrebno dodati atribut E i N koordinate.  

Odabere se Create New Field, Output field name je E, type je Integer. 

U Expression se upiše $x te se u Preview prikaže primjer koordinate.  

Tipkom OK se spremi novo polje u atributnoj tablici. 
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Za N koordinatu je identičan postupak, ali se pod Name upiše N, a u Expression $y. 

 

U atributnoj tablici se sad nalaze i E i N koordinate u HTRS96/TM. 
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Klikom na gornji lijevi ugao tablice, odabere se cijela tablica, a tipkom Copy ili sa CTRL + c se kopira. 

 

U Excelu se desno klikne na praznu ćeliju i odabere pod Paste Options: Match Destination Formatting 

 

Sad se snimljene točke zajedno sa svim prikupljenim podacima i HTRS96/TM koordinatama nalaze u 

tablici za daljnje postupanje. 
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